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Chapter 1

Introduction
This chapter introduces mimio Studio and gives an overview of the mimio Studio software.

About mimio Studio

mimio Studio is a suite of software tools for capturing, creating, and presenting information. When 
used with a mimio capture device and a data projector, mimio Studio turns any whiteboard into a 
powerful interactive presentation tool. Without a projector, mimio Studio records handwritten notes 
and drawings directly from your mimio-enabled whiteboard. You can also use the mimio Studio 
software without a mimio capture device to prepare presentations and manipulate previously 
created content.

With mimio Studio you can:

• Deliver lessons and presentations interactively.
• Prepare interactive lessons and presentations.
• Capture digital ink.

Deliver Lessons and Presentations Interactively
Using Interactive mode, you can deliver lessons and presentations directly from your whiteboard. 
With a projector and a mimio capture device you can project your desktop image onto a 
whiteboard. In Interactive mode, you control the movement of the cursor on your screen with a 
mimio Mouse, much like you would with a mouse at your computer. With the various presentation 
tools found in mimio Tools you can focus your audience on a specific area of the screen by 
displaying only certain parts of the screen. You can also annotate the screen using the Screen 
Annotation feature with the drawing tools available in mimio Tools.

Prepare Interactive Lessons and Presentations
mimio Notebook provides a multi-page work space for creating lessons and presentations. Using 
the mimio Notebook is very similar to using other word processing or presentation software 
applications. mimio Notebook can be used without a whiteboard or mimio capture device.

mimio Notebook provides multiple authoring and editing tools for creating almost any type of 
content. You can use mimio Notebook with mimio Tools to create a variety of objects including text 
boxes, freehand writing and drawing, lines, arrows, and many basic shapes. Images can be 
imported into a Notebook, both as objects and as background images.

Capture Digital Ink
A mimio capture device can be used to record notes and drawings from your whiteboard. In Ink 
Capture mode, you use mimio stylus pens to draw and make notes on your whiteboard, and then 
save an electronic copy of the information. You can use Ink Capture mode whether or not your 
computer is currently connected to the capture device. If your computer is connected, your notes 
are automatically captured in a mimio Notebook. If your computer is not connected, your notes are 
captured and stored in the mimio capture device until you download them to a mimio Notebook.
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Getting Started with mimio Studio

The mimio Studio software includes:

• mimio Notebook
• mimio Tools
• mimio Gallery

After installing mimio Studio, mimio Notebook and mimio Tools open on your desktop.

The following figure shows the mimio Studio software.

You can access many of the features in mimio Studio in several ways; from the menu bar, the 
mimio Tools buttons, and the right-click menus. The available features change depending on what 
you are doing in the software. Be sure to explore the right-click menu options as you work with 
mimio Studio.

About mimio Notebook

You can create and present information with mimio Notebook. Using mimio Notebook is very 
similar to using other word processing or presentation software. Content created in mimio 
Notebook can be saved as mimio INK files or a variety of other file formats including HTML, 
JPEG, PNG, GIF, BMP, TIF, WMF, EMF, and PDF. 

Several ways to access mimio Notebook are shown in the following table.

Gallery

Notebook

Tools

Menu bar

Status bar

To start from the Do this

Desktop Double-click  on the desktop.

Taskbar Right-click , and then choose  mimio Notebook.

Start Menu Point to Programs, mimio Studio, and then choose mimio Notebook.
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The following figure shows the mimio Notebook.

About mimio Tools

mimio Tools provides a comprehensive set of interactive tools and resources to create and present 
information. mimio Tools is used to modify mimio Notebook pages and to make screen annotations 
on the whiteboard. 

Several ways to access mimio Tools are shown in the following table.

Single
Page view

Multi
Page view

Trash can

Status bar

Gallery Settings
Tools

To start from the Do this

Desktop Double-click  on the desktop.

Taskbar Right-click , and then choose  mimio Tools.

Start Menu Point to Programs, mimio Studio, and then choose mimio Tools.

mimio Notebook Do one of the following:

• Double-click  on the status bar.
• Choose  mimio Tools from the Tools menu.

mimio device

(Interactive mode only) 
Press  (New Page) on your mimio device.
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The following figure shows the mimio Tools toolbar.

mimio Tools has two views: a fully expanded view, for easy access to all features, and a 
compressed view, which takes up less space on the screen.
To compress and expand mimio Tools

♦ Double-click  at the top of the mimio Tools toolbar.

About mimio Gallery

mimio Gallery contains elements that can be used to create your lessons and presentations, such as 
images, templates, movies, and previously created lessons. mimio Gallery also contains Screen 
Annotation snapshots. You can customize the Gallery by adding your own elements.

Several ways to access mimio Gallery are shown in the following table.

Zoom

Recorder

Screen Clipping

Fill color

Color palette

Transparency

Applications

Interactive

Screen Annotation

Compress/Expand
toolbar

Selection tool

Import File

Outline color

Thickness

Gallery

More colors

Right-click

Mouse

Reveal

Text Tools

Calculator
Magnify

Web Browser

Spotlight

Drawing tools

To start from Do this

Start Menu Point to Programs, mimio Studio, Tools, and then choose mimio Gallery.

mimio Tools Click  on the mimio Tools toolbar.

mimio Notebook Do one of the following:

• Double-click  on the status bar.
• Choose  Gallery from the Insert menu.
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The following figure shows the mimio Gallery.

mimio Gallery consists of two main folders, a Screen Annotations folder and a Gallery folder. The 
Screen Annotations folder contains all saved Screen Annotation snapshots. The main Gallery folder 
contains a number of different folders used to categorize items, such as Geography, Mathematics, 
and so on. Each of these folders can contain four different types of objects: 

• Images - Images include pictures and graphics.
• Templates - Templates backgrounds and predefined page layouts.
• Multimedia - Multimedia objects include movies, animation, and sound.
• Lessons - Lessons includes lessons created using mimio Notebook and imported documents. 

You can create your own lessons or import lessons created by someone else.

Minimum System Requirements

The minimum system requirements for mimio Studio are:

• Microsoft Windows®-compatible computer with a Pentium II, 450 MHz processor 
• Microsoft Windows 2000, XP, or Microsoft Vista® operating system
• 256 MB RAM minimum (512 MB RAM recommended)
• 120 MB free disk space
• CD-ROM drive or Internet connection to download the software
• Available USB port (required to use a mimio device)
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Using this Guide

This User Guide provides instructions for using the mimio Studio software using the Microsoft 
Windows operating system.

This User Guide includes information for using all parts of the mimio Studio software. Depending 
on the types of mimio devices you have, some sections of this User Guide may not apply to you.

The following table provides a summary of the contents.

User Guide Chapter Description

Introduction This chapter gives an overview of the software and how to access 
mimio Notebook, mimio Tools, and mimio Gallery. 

Using mimio Studio Interactively This chapter describes how to use mimio Studio interactively with your 
mimio-enabled whiteboard using the mimio Mouse. mimio Tools are 
described, as well as recording your actions, and working with Screen 
Annotation snapshots.

Creating Interactive Lessons 
and Presentations

This chapter describes how to create lessons and other presentations 
using mimio Notebook. Included in this chapter are instructions for 
using mimio Tools and the mimio Gallery to create and add items to 
your lessons and presentations.

Using mimio Recorder This chapter describes how to use mimio Recorder to create movies 
(with audio) of your mimio presentations.

Capturing Digital Ink This chapter describes how to capture notes and drawings from a 
mimio-enabled whiteboard as digital ink using mimio stylus pens. 

Sharing the Whiteboard 
Remotely

This chapter describes how to share your mimio-enabled whiteboard 
using Microsoft NetMeeting.

Customizing mimio Studio This chapter describes how to customize the features of mimio Tools, 
mimio Notebook, and mimio Studio in general.

Tips and Troubleshooting This chapter gives troubleshooting information for some common 
problems, and describes how to check for and install mimio Studio 
software updates.
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Chapter 2

Using mimio Studio
Interactively

This chapter describes how to interact with your desktop using a mimio Mouse from a mimio-
enabled whiteboard.

Setting Up Interactive Mode

To use Interactive mode you need a projector, a mimio-enabled whiteboard, and a mimio Mouse. 
Combined, these devices make for a powerful tool for delivering lessons and presentations.

Projecting Your Desktop on a mimio-Enabled Whiteboard
If you are presenting from a mimio Notebook or another application, such as a PowerPoint 
presentation, you can open the application before or after Interactive mode is enabled and the 
whiteboard is calibrated.

To set up for Interactive mode

1 Project your desktop image onto your whiteboard. 
Refer to your projector’s documentation for instructions on how to project your desktop image.

2 Adjust the projected image to have a 2-inch to 3-inch buffer between the edge of your 
projection and your mimio device.

3 Do one of the following:
• Start mimio Tools and click the Interactive button, .
• Press the Interactive button, , on your mimio device. 
• Start mimio Studio Settings, select Interactive, and then click Enable.
• (Optional for systems with a mimio Mouse) Click the mimio Mouse anywhere on the 

whiteboard

 



Using mimio Studio Interactively

8

To exit Interactive mode

♦ Do one of the following:
• Start mimio Tools, click Interactive , and then click Exit.

• Press the Interactive button, , twice on your mimio device. 
• Start mimio Studio Settings, select Interactive, and then click Disable.

See Chapter 7, Customizing mimio Studio for information on how to access mimio Studio 
Settings.

Calibrating Interactive Mode
Each time Interactive mode is enabled, you are prompted to calibrate using a mimio Mouse.

Note When using a permanently installed whiteboard and projector, you do not need to recalibrate 
Interactive mode after the first session. See "Adjusting the Interactive Settings" on page 51.

To calibrate Interactive mode

♦ Press the mimio Mouse down on the whiteboard at the center of each of the nine 
calibration targets.
Make sure to hold the mimio Mouse perpendicular to the writing surface as you click.

The calibration target disappears and the next calibration target appears. 
When the calibration screen disappears, Interactive mode is enabled.

To recalibrate Interactive mode

♦ Do one of the following:
• Start mimio Tools, click the Interactive button, , and then click Recalibrate.

• Press the Interactive button, , on your mimio device. 
• Start mimio Studio Settings, select Interactive, and then click Calibrate.
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Controlling the Desktop Using the mimio Mouse

In Interactive mode, the mimio Mouse can be used to control your desktop and interact with 
applications on your computer from your whiteboard.

The following table describes how to use the mimio Mouse to control your desktop from 
the whiteboard.

Note To change the functions of the mimio Mouse buttons, see "Adjusting the Interactive 
Settings" on page 51.

Using mimio Tools

mimio Tools includes many tools for presenting information in Interactive mode. Sections later in 
this chapter describe how to use the mimio Tools as you deliver your lesson or presentation. See 
"About mimio Tools" on page 3 for information on accessing mimio Tools.

To execute Do this

Left mouse click Click in the projected area at the desired location with the tip of the mimio 
Mouse.

Double left mouse click Quickly click twice in the projected area at the desired location with the tip of 
the mimio Mouse.

Right mouse click 1 Hold the mimio Mouse at the desired location, staying as close to the 
whiteboard as possible without touching it.

2 Press the concave button, , (mouse button A) on the mimio Mouse.

Hover 1 Hold the mimio Mouse at the desired location, staying as close to the 
whiteboard as possible without touching it.

2 Press the convex button, , (mouse button B) on the mimio Mouse.
3 Move the mimio Mouse to the desired location.
4 Release the Hover (convex) button, , on the mimio Mouse.
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Focusing Attention Using the Reveal and Spotlight Tools

The Reveal tool and the Spotlight tool help you to focus your audience on a specific area of the 
screen by keeping parts of the screen hidden.

Using the Reveal Tool
The Reveal tool creates a shade that you can raise and lower over the screen image, as if you are 
moving a shade up or down from the bottom of the screen. You can then expose bullet points or 
other information progressively.

To use the Reveal tool

♦ Do one of the following:
• From mimio Tools, click the Applications button, , and then choose  Reveal.
• (Interactive mode only) From a mimio device, press the Minimize/Maximize Window 

button, , on the mimio device.
To adjust the revealed area

♦ Click inside the shaded area and drag down or up to reveal more or less of the displayed area.
To adjust the transparency of the Reveal tool

1 Click , and then point to Transparent.
2 From the Transparent list, choose a percentage.

A transparency of 0% means that the shaded area will be completely opaque.
To exit the Reveal tool

♦ Do one of the following
• From mimio Tools, click the Close button, .
• (Interactive mode only) From a mimio device, press the Minimize/Maximize Window 

button, , on the mimio device.
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Using the Spotlight Tool
The Spotlight tool masks the entire screen except for a small area, the spotlight. You can then focus 
audience attention on a specific area of the screen. The spotlight area can be reshaped, resized, and 
moved around the screen. 

To use the Spotlight tool 

1 Do one of the following:
• From mimio Tools, click the Applications button,  , and then choose  Spotlight.
• (Interactive mode only) From a mimio device, press the Print Page button, .

2 Click the shaded area outside of the spotlight border and drag the spotlight to the desired 
location.

To adjust the shape of the spotlight

1 Click , and then point to Shape.

2 From the Shape list, choose a shape.
To resize the spotlight

1 Click , and then point to Size.

2 From the Size list, choose a spotlight size.

Note You can also resize the spotlight by dragging the colored border of the spotlight until the 
spotlight is the desired size.

Exit Spotlight tool
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To adjust the spotlight transparency

1 Click , and then point to Transparent.

2 From the Transparent list, choose a transparency percentage.
A transparency of 0% means that the shaded area will be completely opaque.

To exit the Spotlight tool

♦ Do one of the following:
• Click the Close button, .
• (Interactive mode only) From a mimio device, press the Print Page button, , on the 

mimio device.

Marking Up the Display Using Screen Annotations 

Screen Annotation mode allows you to annotate applications, web pages, and images. When in 
Annotation mode, a green border with a faded edge appears around your desktop. To disable this 
border, see "To disable the Annotation mode border" on page 13.

When you exit from Screen Annotation mode, all annotations are cleared from the whiteboard and 
automatically archived in the Screen Annotations folder in mimio Gallery.

Enabling Screen Annotation Mode
To enable Screen Annotation mode

1 Do one of the following
• From mimio Tools, click the Screen Annotation button, , to freeze your current 

desktop image.
• (Interactive mode Only) From a mimio device, press the Copy Page button, .
A green border with a faded edge appears around your desktop.

2 Annotate the screen using mimio Tools.
All object, drawing, and manipulation features in mimio Tools are available in Screen 
Annotation mode.

To exit Screen Annotation mode

♦ Do one of the following:
• From mimio Tools, click the Mouse button, , to “unfreeze” the screen.
• (Interactive mode only) From a mimio device, press the Copy Page button, , on the 

mimio device.
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To disable the Annotation mode border

1 Right-click  in the notification area of the Taskbar and choose  Settings.
2 Select  mimio Notebook from the mimio Studio Settings dialog box.

3 Clear the Enable fullscreen border (Screen Annotation only) check box.
4 Click OK to save the settings.

Annotating the Screen Using mimio Tools
mimio Tools are used to annotate the screen. All object, drawing, and manipulation features in 
mimio Tools are available in Screen Annotation mode.

Note Once you select a drawing tool, that tool remains selected until you select a different 
drawing tool or the selection tool.

See Chapter 3, Creating Lessons and Presentations for a complete description of manipulating 
objects. 

All of the functions and features of the mimio drawing tools that are available in mimio Notebook 
are available in Screen Annotation mode.

Thickness
slider

Outline 
Color

Fill Color

Color
palette
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To use the freehand pen

1 Click the Pen button, . 
2 (Optional) To adjust the line width, drag the Thickness slider.
3 (Optional) To adjust the line color, select a color from the Color Palette.

For additional color choices click .
4 (Optional) To adjust the transparency of the line, click the Transparency button, , and then 

choose a transparency percentage.
5 Place the cursor where you want the ink stroke to start on the page.
6 Drag the cursor to draw ink strokes. 

To highlight a portion of the display

1 Click the Highlighter button, . 
2 (Optional) To adjust the highlighter width, drag the Thickness slider.
3 (Optional) To change the color, select a color from the Color Palette.

For additional color choices click .
4 Place the cursor where you want the highlight stroke to start on the page.
5 Drag the cursor over the area you want to highlight.

To erase ink and highlighting

1 Click the Eraser button, .
2 (Optional) To adjust the eraser width, drag the Thickness slider.
3 Drag the cursor over the ink or highlighter strokes you want to erase. 

To add a line

1 Click the Line button, .
2 To change the line type, click the arrow next to  and choose a line type from the list.
3 (Optional) To adjust the line width, drag the Thickness slider.
4 (Optional) To change the color, select a color from the Color Palette.

For additional color choices click .
5 (Optional) To adjust the transparency of the line, click the Transparency button, , and then 

choose a transparency percentage.
6 Place the cursor where you want the line to start on the page. 
7 Drag the cursor to draw the line.

To add a shape

1 Select the type of shape to draw.

If the desired shape is not visible, click the arrow next to the Triangle button, and choose a 
shape from the list.

2 (Optional) To adjust the outline width, drag the Thickness slider.
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3 (Optional) To change the color, select the Outline Color box, and then select a color from the 
Color Palette.
For additional color choices click .

4 (Optional) To adjust the fill color, select the Fill Color box, and then select a color from the 
Color Palette.
For additional color choices click .

5 (Optional) To adjust the transparency of the shape, click the Transparency button, , and 
then choose a transparency percentage.

6 Place the cursor where you want the shape to start on the page.
7 Drag the cursor to draw the shape.

To add formatted text

1 Click the Text button, . 
2 Place the cursor where you want the text to start on the page.

For a fixed width text box, place the cursor where you want the text box to start on the page 
and then drag to the desired width.

3 Select a font style, size, color, and a paragraph format for the text.
4 Enter text in the text box.

Clearing All Annotations from the Display
When you exit Screen Annotation mode, all annotations are cleared from the display and all 
annotations are automatically preserved as a snapshot of the display. See "Working with Saved 
Annotation Snapshots" on page 19 for information about reviewing and using the snapshots.

Inserting Text Into an Application Using mimio Text Tool 

You can enter text into any text-entry box, field, or page using the mimio Text Tool. The mimio 
Text Tool has three modes for entering text:

• On-Screen Keyboard allows you to enter text through an on-screen keyboard application.
• Write Anywhere allows you to enter text by writing anywhere on the screen. Your handwriting 

is automatically converted into text and entered into the current application.

Note Write Anywhere is not supported on Windows XP 64-bit or Windows Vista.

• Writing Pad allows you to enter text through a small on-screen writing pad. Your handwriting 
is automatically converted into text and input into the current application.

In addition, Write Anywhere and Writing Pad also support gesture recognition, which allows 
handwritten shortcuts to be automatically recognized as commonly used keys.
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To access mimio Text Tool

1 Click the Applications button, , in mimio Tools, and then choose  Text Tools. 
2 Right-click the mimio Text Tool icon , , or  in the notification area of the Taskbar.

3 Choose the mimio Text Tool that you want to use.
•  Keyboard to enable the On-Screen Keyboard. 
•  Write Anywhere to enable Write Anywhere.
•  Writing Pad to enable Writing Pad.

To disable mimio Text Tool

♦ Do one of the following:
• Click the mimio Text Tool icon , , or  in the notification area of the Taskbar.
• Click the Applications button, , in mimio Tools, and then choose  Text Tools. 

Using the On-Screen Keyboard
You can enter text into any application using the On-Screen Keyboard.
To use the On-Screen Keyboard

1 Start the On-Screen Keyboard.
The On-Screen Keyboard appears.

2 Click the cursor in the text-entry box, field, or page where you want to enter the text.
3 Using your mouse or mimio Mouse, press the virtual keys on the on-screen keyboard.

The text is entered into the text-entry box, field, or page that you selected.
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Using Write Anywhere
With Write Anywhere you can enter text into any text-entry box, field, or page, by writing 
anywhere on the screen with the mimio Mouse while in Interactive mode. You can also use Write 
Anywhere with your mouse or other input device from your computer.

Note Write Anywhere is not supported on Windows XP 64-bit or Windows Vista.

To use Write Anywhere

1 Start Write Anywhere.
The Write Anywhere on-screen buttons are displayed.

2 Click the cursor in the text-entry box, field, or page where you want to enter the text.
3 Using your mouse or mimio Mouse write anywhere on the screen. 

Your handwriting is automatically converted to text and entered into the text-entry box, field, 
or page that you selected.

4 Use the on-screen buttons for commonly used keys.

Write Anywhere also supports gesture recognition for commonly used keys. See "Using Gesture 
Recognition" on page 18.

Using Writing Pad
With Writing Pad you can enter text through a small on-screen writing pad using the mimio Mouse 
while in Interactive mode. You can also use Writing Pad with your mouse or other input device 
from your computer.
To use Writing Pad

1 Start Writing Pad.
The on-screen writing pad appears.

2 Click the cursor in the text-entry box, field, or page where you want to enter the text.

Button Description

Backspace

Enter

Tab

Space
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3 Using your mouse or mimio Mouse, write within the yellow space of the on-screen writing 
pad. 
Your handwriting is automatically converted to text and entered into the text-entry box, field, 
or page that you selected.

4 Use the on-screen buttons for commonly used keys.

Writing Pad also supports gesture recognition for commonly used keys. See "Using Gesture 
Recognition" on page 18.

Using Gesture Recognition
With gesture recognition, handwritten shortcuts are automatically recognized as commonly used 
keys. Both Write Anywhere and Writing Pad support gesture recognition.

The following table describes how to use gestures to perform common functions.

Button Description

Backspace

Enter

Tab

Space

To press Do this

Backspace Draw a line from right to left.

Enter Draw a connected line from 
top to bottom and then from 
right to left.

Tab Draw a connected line from 
bottom to top and then from 
left to right.

Space bar Draw a connected line from 
bottom to top and then from 
right to left.
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Using the Web Browser, Calculator, and Magnify Tools

mimio Tools includes shortcuts for accessing a Web browser, a calculator, and a magnifier. 
To use the tools

1 Start mimio Tools.
2 Click the Applications button, , and then choose one of the following tools:

•  Web Browser
•  Calculator
•  Magnify

Recording Desktop Actions and Audio in Interactive Mode

Using mimio Recorder, you can record your mimio interactions into an AVI movie file, with or 
without audio. See Chapter 4, Using mimio Recorder for more information on how to use mimio 
Recorder.

Using the mimio Device Buttons in Interactive Mode

While working in Interactive mode, the mimio device buttons can be used to easily access mimio 
Studio features directly from your whiteboard. The following illustration shows the name of each 
button and the action when working in Interactive mode.

These are the default actions assigned to the mimio device buttons when working in Interactive 
mode. To change the actions of the buttons, see "Adjusting the Interactive Settings" on page 51.

Working with Saved Annotation Snapshots

mimio Studio automatically saves a snapshot of the annotated screen each time you exit Screen 
Annotation mode. These snapshots are saved in the Screen Annotations folder in mimio Gallery. 

Viewing Screen Annotation Snapshots
You can view your saved screen annotations from the Screen Annotations folder in mimio Gallery.
To view Screen Annotation snapshots

1 Start mimio Gallery.
2 Select the Screen Annotations folder.

New Page - Starts/exits mimio Tools

Copy Page - Enables/disables Screen Annotation mode

Print Page - Enables/disables the Spotlight tool
Resize Window - Enables/disables the Reveal tool
Interactive - Starts recalibration
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To select a snapshot

♦ Do one of the following:
• Click on the snapshot to select.
• To select multiple snapshots, press CTRL and select each snapshot.
• To select multiple snapshots that are close to each other, drag a selection rectangle over the 

snapshots.
• To select a range of snapshots, select the first snapshot and then press SHIFT and select 

the last snapshot.
• To select all snapshots, right-click, and then choose Select All.

Renaming an Annotation Snapshot
Screen Annotation snapshots are saved in chronological order, using the date and time that the 
snapshot was created as the name of the snapshot. You can rename a snapshot any time after it has 
been saved. 
To rename a snapshot

1 Select the snapshot to rename.
2 Right-click and choose Properties.
3 Enter a name for the snapshot in the Name field and click OK.

Adding Keywords to an Annotation Snapshot
You can add keywords to any snapshot so that you can use the search bar in mimio Gallery to find 
that snapshot later.

To add keywords to a snapshot

1 Select the snapshot to add keywords to.
2 Right-click and choose Properties.
3 Enter each keyword on a separate line in the Keywords field and click OK.

Searching for an Annotation Snapshot
You can search for a specific snapshot using the search bar in mimio Gallery. You can search for a 
snapshot using a keyword or part of the snapshot name.
To search for a specific snapshot

1 Select the Screen Annotations folder in mimio Gallery.
2 Enter text to search for in the Search field.

All snapshots associated with the text appear in the preview area of mimio Gallery.

Importing an Annotation Snapshot 
You can import a snapshot into an open Notebook.
To import a snapshot 

1 Open a mimio Notebook.
2 Select the snapshot to import.
3 Drag the selected snapshot into the target Notebook.
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Pasting an Annotation Snapshot Into Another Application
Annotation snapshots can be used in other applications such as Microsoft Word or PowerPoint.
To paste a snapshot into another application

1 Select the snapshot to copy.
2 Right-click, and then choose Copy.
3 Navigate to the target application.
4 Right-click, and then choose Paste. 

Alternately, you can drag the selected snapshot into the target application.

Printing Annotation Snapshots
You can print a snapshot directly from the Screen Annotations folder in mimio Gallery.
To print a snapshot

1 Select the snapshot to print.
2 Right-click and choose Print.

Deleting Annotation Snapshots
You can delete snapshots from the Screen Annotations folder.
To delete a snapshot

1 Select the snapshot to delete.
2 Click the Delete button, .

A delete confirmation dialog box appears.
3 Click Yes.
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Chapter 3

Creating Lessons
and Presentations

This chapter describes how to use mimio Notebook to create and present information. 

Working with mimio Notebook

You can create and present information with mimio Notebook. Using mimio Notebook is very 
similar to using other word processing or presentation software. Content created in mimio 
Notebook can be saved as mimio INK files or exported to a variety of other file formats including 
HTML, JPEG, PNG, GIF, BMP, TIFF, WMF, EMF, and PDF. 

See "About mimio Notebook" on page 2 for information on accessing mimio Notebook.

To open an existing mimio Notebook

1 Start mimio Notebook and click .
2 From the Open dialog box, select the mimio file to open and click Open.

To save a Notebook

1 Click the Save button, .
2 From the Save As dialog box, enter a name for your file in the File name field.
3 Choose the desired format from the Save as type list.
4 Click Save. 

When saving in a format, other then INK, the Select Pages dialog box appears.

5 Select the pages to save, by selecting All Pages, Current Pages, or Pages.
6 Choose an export size for the images from the Size list.
7 Click OK.
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Working with Pages
mimio Notebook consists of a series of pages. Pages can be viewed, presented, and edited in three 
different views. 

•  Single Page - This view displays the current page for creating and editing. The Single Page 
view is the default view in the mimio Notebook. 

•  Multi-Page - This view displays all pages as a series of thumbnails for browsing or 
manipulating multiple pages. 

•  Full Screen - This view fills the entire screen with the current page for presenting 
information.

You can insert new pages, import pages from another mimio Notebook, delete pages, and reorder 
pages. You can also change the size of a page or change the background of a page in your mimio 
Notebook.
To insert a new page

♦ Do one of the following:
• Click the New Page button, .
• (Capture mode only) Press the New Page  button on your mimio device.

To select a page

1 Select the Multi Page tab, .
2 Do one of the following:

• To select multiple pages, press CTRL and select a page.
• To select multiple pages that are close to each other, drag a selection rectangle over the 

pages to select.
• To select a range of pages, select the first page, and then press SHIFT and select the last 

page.
• To select all pages, choose Select All from the Edit menu.

To insert a duplicate of an existing page

1 Navigate to the page to duplicate.
2 Do one of the following:

• Choose Duplicate Page from the Insert menu.
• (Capture mode only) Press the Copy Page button , on your mimio device.

To delete a page

1 Select the page to delete in the Multi Page view.
2 Click the Delete button, .

To import a page from another mimio Notebook

1 In Multi Page view, select the page to import from the source mimio Notebook.
2 Click the Copy button,  .
3 Select the location to insert the page in the target mimio Notebook.
4 Click the Paste button, .

Note You can also import pages by dragging the pages from the source mimio Notebook to the 
target mimio Notebook.
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To insert the desktop as a new page

1 From mimio Tools, click the Screen Clipping button, .
The desktop is displayed with a transparent mask.

2 Click the text Click here to capture this Desktop as a New Page.

The desktop is inserted as a new page in the Notebook.

To change the page size

1 Choose Page Setup from the File menu.
The Page Settings dialog box appears.

2 Do one of the following:
• From the Page Size list, choose any of the available display or device sizes.
• From the Page Size list, choose Custom, and then enter the desired valued into the Width 

and Height fields.
3 From the Apply To list, choose one of the following:

• Current Page to apply the page size to the current page only. 
This option is only available from the Single Page view.

• Selected Pages to apply the page size to the selected pages.
This option is only available from the Multi Page view.

• Whole Document to apply the page size to all of the pages in the Notebook.
4 To apply the page size to all new pages, select the All new pages check box.

This option is only available if no device is connected to the mimio Notebook.
5 To apply the page size to all new pages and the currently connected device, select the The 

connected device check box.
This option is only available if a mimio device is connected to the mimio Notebook.
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To change the background color of a page

1 Choose Background from the Insert menu.
The Background dialog box appears.

2 Click Color.
3 From the Color dialog box, select a color, and then click OK.

To change the background image of a page

1 Choose Background from the Insert menu.
2 From the Background dialog box, click Image.
3 From the Open dialog box, select the image file that you want to use as your background.
4 Click Open.

The image is displayed in the Preview area.

Note You can also import an image from another application or from the mimio Gallery to 
use as a background. To do this, select the image and drag to the Preview area. 

5 Select the display mode for the new background from the Mode list.

6 Select which pages to apply the background to from the Apply To list.
To apply the background to all new pages, select the All new pages check box.

To sort pages

1 Select the Multi Page tab, .
2 Select the pages to sort.
3 Drag the selected pages to the desired location.

Mode Result

Place The image is placed in the top left corner of the page and is not resized.

Stretch The image is resized to fill the entire page.

Tile The image is tiled repeatedly to fill the entire page and is not resized.

Center The image is placed in the center of the page and is not resized.
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To print a page

1 Select the pages to print.
2 Click the Print button, .
3 From the Print dialog box, click Print.

Note To print the current page in Ink Capture mode, press the Print Page button  on your 
mimio device.

Adding Objects with mimio Tools

Using mimio Tools, you can create a wide variety of objects on any mimio Notebook page, 
including lines, shapes, and freehand drawing and writing.

See "About mimio Tools" on page 3 for information on accessing mimio Tools.

Creating Objects
mimio Tools provides tools for inserting freehand writing or drawing into your mimio Notebook, as 
well as lines, arrows, basic shapes, and formatted text. You can also import images and multimedia 
objects, or insert a clipping of your screen into your Notebook using mimio Tools.

Note Once you select a drawing tool, that tool remains selected until you select a different 
drawing tool or the selection tool.

Thickness
slider

Outline 
Color

Fill Color

Color
palette
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To use the freehand pen

1 Click the Pen button, . 
2 (Optional) To adjust the line width, drag the Thickness slider.
3 (Optional) To adjust the line color, select a color from the Color Palette.

For additional color choices, click .
4 (Optional) To adjust the transparency of the line, click the Transparency button, , and then 

choose a transparency percentage.
5 Place the cursor where you want the ink stroke to start on the page.
6 Drag the cursor to draw ink strokes. 

To highlight a portion of the display

1 Click the Highlighter button, . 
2 (Optional) To adjust the highlighter width, drag the Thickness slider.
3 (Optional) To change the color, select a color from the Color Palette.

For additional color choices, click .
4 Place the cursor where you want the highlight stroke to start on the page.
5 Drag the cursor over the area you want to highlight.

To erase ink and highlighting

1 Click the Eraser button, .
2 (Optional) To adjust the eraser width, drag the Thickness slider.
3 Drag the cursor over the ink or highlighter strokes you want to erase. 

To add a line

1 Click the Line button, .
2 To change the line type, click the arrow next to  and select a line type from the list.
3 (Optional) To adjust the line width, drag the Thickness slider.
4 (Optional) To change the color, select a color from the Color Palette.

For additional color choices, click .
5 (Optional) To adjust the transparency of the line, click the Transparency button, , and then 

choose a transparency percentage.
6 Place the cursor where you want the line to start on the page. 
7 Drag the cursor to draw the line.

To add a shape

1 Select the type of shape to draw.

If the desired shape is not visible, click the arrow next to the Triangle button, , and select a 
shape from the list.

2 (Optional) To adjust the outline width, drag the Thickness slider.
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3 (Optional) To change the color, select the Outline Color box, and then select a color from the 
Color Palette.
For additional color choices, click .

4 (Optional) To adjust the fill color, select the Fill Color box, and then select a color from the 
Color Palette.
For additional color choices, click .

5 (Optional) To adjust the transparency of the shape, click the Transparency button, , and 
then choose a transparency percentage.

6 Place the cursor where you want the shape to start on the page.
7 Drag the cursor to draw the shape.

To add formatted text

1 Click the Text button, . 
2 Place the cursor where you want the text to start on the page.

For a fixed width text box, place the cursor where you want the text box to start on the page 
and then drag to the desired width.

3 Select a font style, size, color, and a paragraph format for the text.
4 Enter text in the text box.

Note The style and formatting of the text are applied after you have finished entering the text and 
clicked outside of the text box. This means that the appearance of the text while being entered is 
different from the final appearance of the text.

To import a picture or multimedia object

1 From mimio Tools, click the Import File button, . 
2 From the Open dialog box, select the file to import.
3 Click Open.

The image is displayed on the Notebook page.

Note You can also copy and paste images from another application, or drag images from another 
application into mimio Notebook.

To insert a screen clipping

1 From mimio Tools, click the Screen Clipping button, .
The desktop is displayed with a transparent mask.

2 Drag the cursor to draw a selection box around the area to capture.
The selected area is inserted in the Notebook page.
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Manipulating Objects
Objects on a page can be moved, rotated, copied, deleted, locked, and have their 
properties adjusted.
To select an object

1 Start mimio Tools.
2 Click the Selection button, .
3 Do one of the following:

• Click the object to select.
• To select multiple objects, press CTRL and select each object.
• To select multiple objects that are close to each other, drag a selection rectangle over the 

objects to select.
• To select all objects on a page, choose Select All from the Edit menu.

To move an object

1 Select the object to move.
2 Position the cursor over the object. 

The cursor changes to the move cursor, .
3 Drag the object to the desired location.

To resize an object

1 Select the object to resize.
A frame is displayed around the object.

2 Position the cursor over one of the white sizing handles. 
The cursor changes to the resize cursor, .

3 Drag the cursor to resize the object.

Note Press and hold the SHIFT key to constrain proportions during resizing.
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To rotate an object

1 Select the object to rotate.
A frame is displayed around the object.

2 Position the cursor over the green rotation handle. 
The cursor changes to the rotation cursor, . 

3 Drag the cursor to rotate the object.
To snap to one of the predefined 45° increments, move the rotate cursor and release over the 
predefined rotation anchor point.

To lock the position and properties of an object

1 Select the object to lock.
2 From the Format menu, point to Locking, and then choose Lock.

Note A locked object cannot be selected.

To unlock an object

♦ From the Format menu, point to Locking, and then choose Unlock All.
Objects can only be unlocked collectively; you cannot unlock individual objects.

To delete an object

1 Select the object to delete.
2 Drag the object to the trash can icon.

To reorder objects

1 Select the object to reorder.
2 Choose Order from the Format menu.
3 Choose how to order the object.

Option Action

 Front Brings the selected object to the front of the order.

 Back Sends the selected object to the back of the order.

  Forward Steps the object forward in the order, by one.

  Backward Steps the object backward in the order, by one.
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To group objects

1 Select the objects to group.
2 From the Format menu, point to Grouping, and then choose  Group.

To ungroup objects

1 Select the objects to ungroup.
2 From the Format menu, point to Grouping, and then choose  Ungroup.

To edit object properties

1 Select the object to edit.
2 To adjust the line width, drag the Thickness slider.
3 To adjust the color, select the Outline Color box or the Fill Color box, and then select a color 

from the Color Palette.
For additional color choices, click .

4 To adjust the transparency, click the Transparency button, , and then choose a transparency 
percentage.

To edit text

1 Double-click the text box.
2 Select the text to adjust, or enter new text.
3 Adjust the font style, size, color or paragraph format.

To import an object from another mimio Notebook page

1 Select the object to import from the source mimio Notebook page.
2 Click the Copy button, .
3 Navigate to the target mimio Notebook page.
4 Click the Paste button, .

Note You can also import an object by dragging the object from the source page to the target 
page.

To convert ink to text

1 Select the objects to convert. 
All selected objects are combined into one text object.

2 Do one of the following:
• Choose  Recognize Ink from the Tools menu.
• Right-click, and then choose  Recognize Ink.
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To snap objects to grid

1 Choose  Grid from the View menu.
The Grid dialog box appears.

2 To force objects to snap to grid, select the Snap objects to grid check box.
3 To allow objects to snap to angles, select the Snap objects to angles check box.
4 To adjust the spacing between grid snap locations, enter the desired value into the Spacing 

field.
5 To display a grid on the screen, select the Display grid on screen check box.
6 To make the grid settings permanent for all new mimio Notebooks, select the Set as default 

for all new Notebooks check box and click OK.

Hyperlinking Objects
Objects can have hyperlinks associated with them. Hyperlinks can open files, web pages, or a 
different page within a mimio Notebook. When a hyperlink is associated with an object, a link 
appears at the bottom left of the object.

Note You can add a hyperlink to any object that you create or import into a mimio Notebook; you 
cannot add a hyperlink to a template or background.

To add a hyperlink to an object

1 Select the object to add the hyperlink to.
2 Choose Hyperlink from the Insert menu.

The Edit Hyperlink dialog box appears.
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3 Choose Existing file or Web Page from the Link To list.
Alternately, select a page from within the current Notebook from the Link To list.

4 Enter a file name or web address to link to in the Address field.
Alternately, click Browse to search for a file to link to.

5 Click OK to insert the hyperlink.
To remove a hyperlink from an object

1 Select the object with the hyperlink to remove.
2 Choose Hyperlink from the Insert menu.

The Edit Hyperlink dialog box appears.

3 Click Remove Link.

Adding Objects from mimio Gallery

mimio Gallery consists of two main folders, a Screen Annotations folder and a Gallery folder. The 
Screen Annotations folder contains all saved Screen Annotation snapshots. The main Gallery folder 
contains a number of different folders used to categorize items, such as Geography, Mathematics, 
and so on. Each of these folders can contain four different types of objects: 

• Images - Images include pictures and graphics.
• Templates - Templates backgrounds and predefined page layouts.
• Multimedia - Multimedia objects include movies, animation, and sound.
• Lessons - Lessons includes lessons created using mimio Notebook and imported documents. 

You can create your own lessons or import lessons created by someone else.

See"About mimio Gallery" on page 4 for information on accessing mimio Gallery.
To navigate mimio Gallery

♦ Click any folder to view the available items in that folder.
♦ Click the plus sign next to a Gallery folder to see any subfolders that are contained in that 

Gallery folder.
To select a Gallery item

1 Navigate to the Gallery folder that contains the item you want to select.
2 Do one of the following:

• Click the Gallery item to select.
• To select multiple items, press CTRL and select each item.
• To select multiple items that are close to each other, drag a selection rectangle over the 

items to select.
• To select a range of items, select the first item, and then press SHIFT and select the last 

item.
• To select all items, right-click, and then choose Select All.
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Importing Gallery Items into a mimio Notebook
You can import any Gallery item into a mimio Notebook to add to your presentation.
To import a Gallery item into a mimio Notebook

1 Select the image, template, multimedia item, or lesson to import.
2 Drag the item into the mimio Notebook.

Note You can also import items by double-clicking or by copying and pasting them into a 
Notebook.

Customizing the Content of the mimio Gallery
The mimio Gallery is fully expandable and modifiable, so you can add your own folders, pictures, 
templates, multimedia items, and lessons.

Note mimio Studio does not support network or shared galleries. 

To import a Gallery folder from a Gallery file

1 Select the Gallery folder to import the Gallery (MCF) file to.
2 Click the Import Content button, .
3 From the Open dialog box, navigate to and select the Gallery file to import.
4 Click Open.

To add a new Gallery folder

1 Select the main Gallery folder or a Gallery subfolder to add the new folder to.
2 Click the New Folder button, .

The Gallery Item Properties dialog box appears.

3 Enter a name for the new folder in the Name field.
4 (Optional) Enter a keyword in the Keywords field to make the new folder searchable from the 

Gallery search bar.
5 Click OK.
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To add a new item to a folder

1 Select the folder to add the item to.
2 Click inside of the preview area of the Gallery.
3 Click the Insert File button, .
4 From the Open dialog box, navigate to and select the file to import.
5 Click Open.

The item is inserted in the appropriate area of the Gallery folder.

Note You can also add a new items by selecting one or more items, and then dragging and 
dropping or copying and pasting them into a Gallery folder.

To add a Word, PowerPoint, or PDF document to a folder

1 On your computer, navigate to and select the file to import.
2 Right-click the file, and then choose Copy.
3 In the Gallery, select the folder to import the document to.
4 Click the Paste button, .

Note All imported documents are placed in the Lessons section of the mimio Gallery.

To create a template from a Notebook image

1 Right-click and drag the image into the Gallery.
The right-click menu appears.

2 Choose Insert as template.

To copy an existing Gallery item

1 Select the Gallery item to copy.
2 Click the Copy button, .
3 Select a Gallery folder to insert the new item into.
4 Click the Paste button, .

The item is inserted in the appropriate area of the Gallery folder.
To delete a Gallery item

1 Select the Gallery item to delete.
2 Click the Delete button, .

A delete confirmation dialog box appears.
3 Click Yes.
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To find similar Gallery items

1 Right-click the Gallery item, and then choose Open Folder.
2 If the item is contained in more than one folder, choose the folder to open.

The folder containing the selected item opens in mimio Gallery.

Exporting a Gallery Folder to a Gallery File
Entire Gallery folders can be exported and imported into the mimio Gallery as Gallery (MCF) files. 
You can then share Galleries that you have created with other mimio Studio users.

Note mimio Studio does not support network or shared galleries. 

To export a Gallery folder to a Gallery file

1 Select the Gallery folder to export. 
2 Click the Export Content button, .
3 From the Save As dialog box, enter a name for the file in the File Name field. 
4 Select a location to save the file to.
5 Click Save.

Importing Documents

You can import Word, PowerPoint, and PDF documents into a mimio Notebook.

To import a document

1 Choose Import from the File menu.
2 From the Open dialog box, select the document file to import.
3 Click Open.

The document is inserted into the Notebook.

Delivering Interactive Notebook Lessons and Presentations

mimio Notebook can be used to deliver lessons and presentations that were created in or imported 
into a mimio Notebook.

Using Fullscreen View
For presenting information, the Full Screen view can be used to fill the entire screen with the 
current page.

All mimio Tools are available in Fullscreen view. For more information, see Chapter 2, Using 
mimio Studio Interactively.
To access the Fullscreen view

♦ Click the Fullscreen button, .
The current page fills the entire screen and the Fullscreen navigation bar appears.
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Navigating Through a Presentation
To navigate through a Notebook presentation

♦ Use the Fullscreen navigation bar to navigate through the Notebook presentation.

Working with Multimedia Objects
You can play, pause, fast forward, and rewind movie, animation, and sound objects you added to 
your presentation.
To play video or audio

♦ Click anywhere on the movie, animation, or sound object to play.
To show and hide the video and audio controls

1 While the video or audio is playing, click once anywhere on the object to view the object 
controls.

2 Click the object again to hide the controls.
To pause, fast forward, or rewind video or audio

♦ Do one of the following:
• To pause the video or audio, click .
• To fast forward the video or audio, drag the slider to the right.
• To rewind the video or audio, drag the slider to the left.

Button Action

Use this button to exit the Fullscreen view.

Use this button to insert a new page 

Use this button to skip to the previous page in the Notebook.

Use this button to advance to the next page in the Notebook.
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Chapter 4

Using mimio
Recorder

mimio Recorder can capture a live desktop, synchronized with audio, as a video file. You can save 
the file in two formats: mimio and Microsoft. Both are AVI files, however, the mimio format can 
only be played back using mimio software. The Microsoft formatted AVI file can be played back in 
most Windows media players.

To import a video file you have already created elsewhere into mimio Notebook, see "Customizing 
the Content of the mimio Gallery" on page 35 and "Importing Gallery Items into a mimio 
Notebook" on page 35.

This chapter describes how to use mimio Recorder to create movies of your mimio presentations 
with support for synchronized audio.

Using mimio Recorder

mimio Recorder allows you to record your mimio interactions as an AVI movie file with the option 
to record audio as well. 

The following table shows several ways to access mimio Recorder.

To save a recording

1 Choose  Save from the File menu.
2 From the Save As dialog box, enter a name for the file in the File name field.
3 Click Save.

To start from Do this

Taskbar Right-click , and then choose  mimio Recorder.

Start Menu Point to Programs, mimio Studio, Tools, and then choose mimio Recorder.

mimio Tools Click the Applications button, , and then choose  Recorder.
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Recording a Presentation

The mimio Recorder can be used to easily record presentations using the standard record, pause, 
stop, and play features.
To start recording

1 Start mimio Recorder. 
2 Click the arrow to the right of the Record button, , and then choose a recording option from 

the list.

3 Just before you start your presentation, click the Record button, .
• If you chose Record Window, select the window to record.
• If you chose Record Area, click and drag a selection box around the area to record.

Note While recording, mimio Recorder automatically minimizes and is displayed in the 
system tray as the mimio Recorder icon, . 

To pause recording

♦ Click  in the system tray. 
This pauses the recording and opens the mimio Recorder window. 

To resume recording 

♦ Click the Record button, .
To stop a recording

1 Click  in the system tray. 
This pauses the recording and opens the mimio Recorder window. 

2 Click the Stop button, .

To preview a recording

♦ Click the Play button, . 
Your default media player is started and your recording plays automatically.

Note Close your media player before starting a new recording.

Option Description

 Record Desktop Records the entire desktop. (Default)

 Record Window Records a specific window.

 Record Area Records a selected area of the screen.
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Chapter 5

Capturing
Digital Ink

A mimio capture device can be used to record notes and drawings from your whiteboard. This is 
called capturing digital ink. 

You can use Ink Capture mode whether or not your computer is currently connected to the mimio-
enabled whiteboard. When connected, your notes are automatically captured in a mimio Notebook. 
If the mimio-enabled whiteboard is not currently connected, your notes are captured and stored in 
the mimio capture device, until you can download them into a mimio Notebook.

This chapter describes how to record digital ink using the mimio stylus pens and the mimio eraser.

Getting Ready to Capture Digital Ink

You need to configure your mimio capture device, stylus pens, and eraser to capture digital ink. 

Setting Up Ink Capture Mode for a mimio Notebook Session
Using Ink Capture mode, you can make notes on your whiteboard and instantaneously capture them 
into a mimio Notebook.
To connect if the Notebook is configured for Ink Capture mode

♦ Do one of the following:
• Open a new Notebook and your mimio device automatically connects.
• Start drawing on your whiteboard with a mimio stylus pen. A new mimio Notebook 

automatically opens and begins capturing ink.
To connect if the Notebook is configured for Interactive mode

1 Open a new mimio Notebook.
2 From the File menu, point to Connect, and then choose one of the available mimio devices to 

connect to.

Setting Up Ink Capture Mode for an Offline Session
Your mimio device can capture and store ink while disconnected from your computer. However, 
you need to supply power to your mimio device using batteries or a wall adapter.
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Writing and Drawing Digital Ink

In Ink Capture mode, the mimio stylus pens and the mimio eraser are used to draw and erase ink on 
your whiteboard.

Note The color recorded matches the color of the stylus end cap, regardless of the color of the 
marker that is inserted.

To draw digital ink

1 Choose one of the colored mimio stylus pens.

2 Draw on the whiteboard with the stylus pen. 
Keep the stylus pen within 15 degrees of its perpendicular position to the whiteboard to ensure 
that the data is accurately captured.

To erase digital ink

1 Choose the small or larger eraser.

2 Erase the ink from the whiteboard using the eraser. 
Keep the eraser surface flat against the whiteboard to ensure that the data is accurately erased.

Small eraser

Large eraser
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Using the mimio Device Buttons in Ink Capture Mode

While in Ink Capture mode, the mimio device buttons can be used to easily access features directly 
from your whiteboard.

The device buttons work as follows when Ink Capture mode is enabled.

Downloading Digital Ink

Your mimio device can be used to record Digital Ink while the whiteboard is disconnected from 
your computer. Digital Ink recorded while disconnected can be downloaded to a mimio Notebook 
for printing, distributing, or editing. While disconnected your mimio capture device must be 
powered by batteries or by an optionally available wall power supply.
To download digital ink

1 Connect the mimio capture device to your computer.
2 Do one of the following:
• If configured to automatically download digital ink (default), open a new mimio 

Notebook. 
The ink download process begins automatically.

• If configured to manually download digital ink, open a new mimio Notebook and double-
click  Download Ink on the status bar.

New Page - Inserts a new page into mimio Notebook

Copy Page - Inserts a duplicate of the current page into mimio Notebook

Print Page - Prints the current page
Resize Window - Minimizes or maximizes the mimio Notebook
Interactive - Exits Ink Capture mode and starts Interactive mode
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Chapter 6

Sharing the
Whiteboard

Remotely
This chapter describes how to share a presentation displayed on a mimio-enabled whiteboard with 
Microsoft NetMeeting®.

Setting up mimio Studio with NetMeeting

mimio Studio is capable of automatically connecting your whiteboard to an open NetMeeting 
session. mimio Studio and NetMeeting can be used together in both Interactive and Recording 
modes. 
To use NetMeeting interactively

1 Start the NetMeeting application. 
Consult the Microsoft NetMeeting documentation if necessary.

2 Start mimio Studio in Interactive mode.
See “Setting Up Interactive Mode” on page 7.

3 Use the mimio Mouse to select tools and add content directly onto the NetMeeting 
Whiteboard.

To use NetMeeting with Digital Ink

1 Start the NetMeeting application and the NetMeeting Whiteboard. 
Consult the Microsoft NetMeeting documentation if necessary.

2 Use the mimio stylus pens and eraser on the mimio-enabled whiteboard.
Your content is shared on the NetMeeting Whiteboard.
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Adjusting the NetMeeting Settings

The NetMeeting settings allow you to enable/disable Microsoft NetMeeting support and adjust the 
device associated with the NetMeeting Whiteboard.
To access the NetMeeting Settings

1 Start mimio Studio Settings.
2 Click  NetMeeting.

To enable NetMeeting interaction

♦ Select the Enable NetMeeting Interaction check box.
To disable NetMeeting interaction

♦ Clear the Enable NetMeeting Interaction check box.
To set up NetMeeting support for a specific mimio device

♦ Choose the device that you want to use with NetMeeting from the Device list. 
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Chapter 7

Customizing
mimio Studio

This chapter describes the general features of mimio Tools, mimio Notebook, and mimio Studio 
Settings.

The following table shows several ways to access mimio Studio Settings.

mimio Studio Settings contains options for setting and customizing the properties and 
characteristics of your mimio system, including mimio Notebook, mimio Tools, mimio Recorder, 
Devices, Interactive, NetMeeting, Pens, and Recognition.

To change the settings

1 From the mimio Studio Settings dialog box, select the setting you want to change from the list 
on the left.

2 Make the changes you want to the settings.
See later sections in this chapter for a complete description of all settings.

3 Click Apply.

To start from Do this

Taskbar Right-click , and then choose  Settings.

mimio Notebook Do one of the following:

• Double-click  on the status bar.
• Choose  Settings from the Tools menu.
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Adjusting mimio Notebook Settings

mimio Notebook Settings provides options for setting the general parameters of mimio Studio, the 
default interaction mode with mimio devices, and the treatment of digital ink data recorded and 
stored in local storage on a mimio capture device. 

The following tables describe the mimio Notebook settings.

General Settings

Mode Settings

Local Storage Settings

Setting Description

Enable audio feedback Enables sound from a mimio device when buttons are 
pressed or the device is connected or disconnected from 
the computer.

Enable smooth ink and objects Enables smooth or anti-aliased ink, objects, and text. 
Disabling this setting can increase the performance of 
the application.

Enable auto recovery Enables the automatic recovery of data if mimio Studio 
quits unexpectedly.
When this setting is enabled, mimio Notebook saves ink 
data to a backup file every 10 minutes.

Enable trashcan Places the trashcan on the mimio Notebook as an easy 
method for deleting content.

Enable fullscreen border 
(Screen Annotation only)

Enables the border during Screen Annotation mode. See 
“Marking Up the Display Using Screen Annotations” on 
page 12.

Setting Description

Interactive Starts mimio Notebook in Interactive mode.

Ink Capture Starts mimio Notebook in Ink Capture mode.

Connect to available device on file new Automatically connect devices to newly opened mimio 
Notebooks.

Connect to device when any pen is used Automatically open a mimio Notebook in Ink Capture mode 
when a mimio stylus pen touches the whiteboard.

Setting Description

Download data when local storage is 
detected

Automatically download digital ink to a new Notebook when 
a mimio capture device is detected by your computer.

Clear local storage after successful 
download

Automatically clear digital ink from a mimio capture device 
after the information is downloaded to a Notebook.
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Adjusting mimio Recorder Settings

The mimio Recorder Settings allow you to adjust the video and audio quality used for recording 
mimio sessions. 

The following table describes the mimio Recorder settings.

Adjusting the Device Settings

The Device Settings allow you to change the surface size and mounting location for a connected 
mimio device. You can also create a combined surface using two or more mimio capture devices.

The Surface Size and Mounting Location settings are not available for the mimio Board.

To adjust the settings for a mimio device

1 Choose the device to adjust from the Device list.
2 Make the changes you want to the settings.
3 Click Apply.

To adjust surface size for a mimio device

1 Do one of the following:
• Choose a size from the Surface Size list.
• Choose Custom from the Surface Size list and enter the desired values into the Width 

and Height fields.
• Click Auto Size and touch a mimio stylus pen at the location shown.

Setting Description

Video Quality Choose the quality to use to record video.

Audio Quality Choose the quality to use to record audio.

Video Format Choose the format for recording a movie.

Touch the 
stylus pen here
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To adjust the mounting location for a mimio device

Note The sensors on the mimio device must point in toward the writing surface. Refer to the 
Setup Guide for mimio.

To view device information

♦ Click Settings.
The dialog box appears showing the device information, environmental analysis, and 
device memory.

Location Description

Vertical – Top Left
Default

The mimio device is mounted vertically and aligned with the top left 
corner of the whiteboard (maximum size is 4’ tall x 8’ wide).

Vertical – Top Right The mimio device is mounted vertically and aligned with the top right 
corner of the whiteboard (maximum size is 4’ tall x 8’ wide).

Vertical – 
Bottom Left

The mimio device is mounted vertically and aligned with the bottom 
left corner of the whiteboard (maximum size is 4’ tall x 8’ wide).

Vertical – 
Bottom Right

The mimio device is mounted vertically and aligned with the bottom 
right corner of the whiteboard (maximum size is 4’ tall x 8’ wide).

Horizontal – 
Top Left

The mimio device is mounted horizontally and aligned with the top left 
corner of the whiteboard (maximum size is 8’ tall x 4’ wide).

Horizontal – 
Top Right

The mimio device is mounted horizontally and aligned with the top 
right corner of the whiteboard (maximum size is 8’ tall x 4’ wide).

Horizontal – 
Bottom Left

The mimio device is mounted horizontally and aligned with the top 
right corner of the whiteboard (maximum size is 8’ tall x 4’ wide).

Horizontal – 
Bottom Right 

The mimio device is mounted horizontally and aligned with the bottom 
right corner of the whiteboard (maximum size is 8’ tall x 4’ wide).



Adjusting the Interactive Settings

51

To create a combined surface

1 Connect two or more mimio devices to your computer.
2 Set the surface size for each mimio device.
3 Click Combine.

4 Choose the arrangement of your combined surfaces from the Extend Surface Styles list.
5 Press the New Page button, , on each mimio device, in the order shown.
6 Enter a name for your extended surface in the Extend Surface Name field and click OK.

To reset to the default device settings

♦ Click Defaults.

Adjusting the Interactive Settings

The Interactive Settings allow you to calibrate or enable (if calibration has already been done) 
Interactive mode. The Interactive settings also contain settings for changing the functions of mimio 
Mouse and mimio device buttons. 

The following table describes the Interactive general settings.

The following table describes the Interactive actions and commands settings.

Setting Description

Use previous calibration Prevents you from having to calibrate each time you start Interactive mode.

Select this setting if you have a permanently installed whiteboard 
and projector.

Automatically enable 
when a device is detected

Automatically starts Interactive mode when a mimio capture device is 
connected to your computer.

Setting Description

Action List of the mimio Mouse and mimio Device buttons.

Function List of the functions that you can associate with a mimio Mouse or mimio 
Device button.
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Adjusting the Pen Settings

The Pen Settings allow you to change the width and color assignment for each mimio stylus pen. 
You must have a mimio device installed on your computer to adjust the Pen Settings. These settings 
are only used when your mimio device is used to record digital ink.
To adjust the pen settings

1 Choose the pen to adjust from the Pen list.
2 To adjust the line thickness of the pen, drag the Pen Width slider.

Alternately, enter a value into the Pen Width field.
3 To adjust the pen color, select a color from the Pen Color palette.

For additional color choices, click More Colors.
4 Click Apply.

Adjusting the Recognition Settings

You can set the language to use with the Recognize Ink feature. See "To convert ink to text" on 
page 32 for more information about how to use Ink Recognition.

To adjust the recognized language

1 Choose a language from the Language list.
2 Click Apply.
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Chapter 8

Tips and
Troubleshooting

This chapter describes how to check for and install mimio Studio software updates, and how to 
troubleshoot some common problems.

Updating the Software

The Software Update settings allow you to check for and install mimio Studio software updates.

Note You must be connected to the Internet to check for updates.

To check for software updates

1 Start mimio Studio Settings.
2 Select  Software Update.

3 Click Check for Updates.
A list of available updates is displayed.

To turn on automatic update notification

♦ Select Notify me when updates are available, and then click OK.
To install software updates

1 Select the updates you want to install.
2 Click Install.
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Troubleshooting

To test for environmental interference

1 Start mimio Studio Settings.
2 Select  Devices, and then click Settings.

3 Under Environmental Analysis, click Test.

Contacting Support

mimio maintains an Internet Web site, www.mimio.com, that offers support for mimio product. In 
addition, mimio’s Technical Support department is available by phone between 9 A.M. and 8 P.M. 
Eastern time.
Web site: www.mimio.com
Phone: (877) 846-3721
Visit the Support section of our Web site at www.mimio.com to contact us by email.

http://www.dymo.com
http://www.dymo.com
http://www.dymo.com


  55

Index

B
background

color 26
images 26

C
Calculator Tool 19
calibrating Interactive Mode 8
combining surfaces 51
converting ink to text 32

D
deleting

gallery items 36
objects 31
pages 24
screen annotations 21

device buttons
changing functions 51
Ink Capture Mode 43
Interactive Mode 19

device settings
accessing 49
changing surface size 49
combining surfaces 51
mounting location 50

digital ink
capturing 41
downloading 43
drawing 42
erasing 42

drawing
erasing 14, 28
highlighting 14, 28
lines 14, 28
pen 14, 28
shapes 14, 28
text objects 15, 29

E
editing

object properties 32
text 32

exporting
gallery files 37

G
gallery

accessing 4
adding folders 35
copying items 36
deleting items 36
finding similar items 37
gallery files 37
importing into notebook 35
navigating 34
overview 4, 34
selecting items 34
templates 36

gallery files 37
gesture recognition 18
grid 33
grouping, objects 32

H
highlighting, drawing 14, 28
hyperlinks

inserting 33
removing 34

I
importing

documents 36, 37
gallery files 35
multimedia 29
objects 32
pages 24
pictures 29
screen annotations 20

Ink Capture Mode
accessing 41
drawing digital ink 42
erasing digital ink 42
overview 41
setting up 41
settings 48

installing, software updates 53



56   

Interactive Mode
overview 1
accessing 7
calibrating 8
device buttons 19
exiting 8
recalibrating 8
setting up 7
settings 48, 51

L
lines, drawing 14, 28
locking

objects 31

M
Magnify Tool 19
mimio devices

accessing 49
mimio Mouse

overview 9
settings 51

mimio Studio
getting started 2
overview 1

multimedia objects
importing 29
presenting 38

N
NetMeeting

overview 45
settings 46

notebook
overview 2, 23
accessing 2
opening 23
pages 24
saving 23
settings 48

O
objects

converting to text 32
deleting 31
editing 32
grouping 32
importing 32
locking 31
moving 30
ordering 31
resizing 30
rotating 31
selecting 30
snapping to grid 33
ungrouping 32
unlocking 31

On-Screen Keyboard 16

P
pages

background 26
changing the size 25
copying 24
deleting 24
importing 24
inserting 24
inserting the desktop 25
printing 27
selecting 24
sorting 26

pen settings 52
pictures

adding to gallery 36
importing from a file 29
importing from gallery 35

presenting
fullscreen view 37
multimedia objects 38
navigating 38
overview 37

printing
pages 27
screen annotations 21

R
recalibrating Interactive Mode 8
recognition

settings 52
recognize ink 32



    

  57

recorder
accessing 39
overview 39
pausing 40
playing 40
saving 39
settings 49
starting 40
stopping 40

Reveal Tool
overview 10
accessing 10
adjusting 10
exiting 10
transparency 10

S
saving

file types 2
pages 23

Screen Annotation Mode
overview 12
accessing 12
border 13, 48
clearing annotations 15
exiting 12
tools 13

screen annotations
adding keywords 20
deleting items 21
importing 20
pasting to another application 21
printing 21
renaming 20
searching 20
selecting 20
viewing 19

screen clippings 29
searching

screen annotations 20
selecting

gallery items 34
objects 30
pages 24
screen annotations 20

settings 49
accessing 47
changing 47
device information 50
Interactive 51
mimio devices 49

changing button functions 51

changing surface size 49
combining surfaces 51
mounting location 50

mimio Notebook 48
mimio Recorder 49
mimio Studio 47
NetMeeting 46
pens 52
recognition 52
software updates 53

shapes, drawing 14, 28
software updates 53
sorting

pages 26
Spotlight Tool

overview 11
accessing 11
exiting 12
moving 11
shape 11
sizing 11
transparency 12

system requirements 5

T
testing for interference 54
text

editing 32
entering 15
See also Text Tool

Text Tool
accessing 16
exiting 16
gesture recognition 18
On-Screen Keyboard 16
overview 15
Write Anywhere 17
Writing Pad 17

tools
accessing 3
annotation 13
Calculator Tool 19
compressing 4
drawing 27
expanding 4
Magnify Tool 19
overview 3
Reveal Tool 10
Spotlight Tool 11
Web Browser Tool 19

troubleshooting
testing for interference 54



58   

U
ungrouping, objects 32
unlocking

objects 31

V
views 24, 37

W
Web Browser Tool 19
Write Anywhere 17
Writing Pad 17


	Copyright
	Trademarks
	Contents
	Introduction
	About mimio Studio
	Deliver Lessons and Presentations Interactively
	Prepare Interactive Lessons and Presentations
	Capture Digital Ink

	Getting Started with mimio Studio
	About mimio Notebook
	About mimio Tools
	About mimio Gallery
	Minimum System Requirements
	Using this Guide

	Using mimio Studio Interactively
	Setting Up Interactive Mode
	Projecting Your Desktop on a mimio-Enabled Whiteboard
	Calibrating Interactive Mode

	Controlling the Desktop Using the mimio Mouse
	Using mimio Tools
	Focusing Attention Using the Reveal and Spotlight Tools
	Using the Reveal Tool
	Using the Spotlight Tool

	Marking Up the Display Using Screen Annotations
	Enabling Screen Annotation Mode
	Annotating the Screen Using mimio Tools
	Clearing All Annotations from the Display

	Inserting Text Into an Application Using mimio Text Tool
	Using the On-Screen Keyboard
	Using Write Anywhere
	Using Writing Pad
	Using Gesture Recognition

	Using the Web Browser, Calculator, and Magnify Tools
	Recording Desktop Actions and Audio in Interactive Mode
	Using the mimio Device Buttons in Interactive Mode
	Working with Saved Annotation Snapshots
	Viewing Screen Annotation Snapshots
	Renaming an Annotation Snapshot
	Adding Keywords to an Annotation Snapshot
	Searching for an Annotation Snapshot
	Importing an Annotation Snapshot
	Pasting an Annotation Snapshot Into Another Application
	Printing Annotation Snapshots
	Deleting Annotation Snapshots


	Creating Lessons and Presentations
	Working with mimio Notebook
	Working with Pages

	Adding Objects with mimio Tools
	Creating Objects
	Manipulating Objects
	Hyperlinking Objects

	Adding Objects from mimio Gallery
	Importing Gallery Items into a mimio Notebook
	Customizing the Content of the mimio Gallery
	Exporting a Gallery Folder to a Gallery File

	Importing Documents
	Delivering Interactive Notebook Lessons and Presentations
	Using Fullscreen View
	Navigating Through a Presentation
	Working with Multimedia Objects


	Using mimio Recorder
	Using mimio Recorder
	Recording a Presentation

	Capturing Digital Ink
	Getting Ready to Capture Digital Ink
	Setting Up Ink Capture Mode for a mimio Notebook Session
	Setting Up Ink Capture Mode for an Offline Session

	Writing and Drawing Digital Ink
	Using the mimio Device Buttons in Ink Capture Mode
	Downloading Digital Ink

	Sharing the Whiteboard Remotely
	Setting up mimio Studio with NetMeeting
	Adjusting the NetMeeting Settings

	Customizing mimio Studio
	Adjusting mimio Notebook Settings
	General Settings
	Mode Settings
	Local Storage Settings

	Adjusting mimio Recorder Settings
	Adjusting the Device Settings
	Adjusting the Interactive Settings
	Adjusting the Pen Settings
	Adjusting the Recognition Settings

	Tips and Troubleshooting
	Updating the Software
	Troubleshooting
	Contacting Support

	Index

